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Welcome to JClass DesktopViews
Using this Installation Guide ■ Supported Platforms

Thank you for purchasing or evaluating JClass DesktopViews! JClass DesktopViews is 
composed of the following products:

■ JClass Chart 3D, which adds powerful, three-dimensional graphing capabilities to 
Java.

■ JClass Chart, which allows you to develop sophisticated charting applications with 
components, or develop fast, effective chart solutions with the MultiChart and 
SimpleChart Java Beans.

■ JClass DataSource, which allows you to develop sophisticated applications that 
connect to databases and access hierarchical data.

■ JClass Elements, which is a collection of pre-built, pre-tested, GUI JavaBean 
components and utilities designed to enhance and extend Swing.

■ JClass Field, which is a set of JavaBeans that allows data input and validations for a 
wide array of data types, making it easy to create forms and add data input and 
validations to your applications.

■ JClass HiGrid, which is a unique RAD outline-grid with a hierarchical data source for 
managing, displaying, and updating master-detail relation data in one easy-to-use 
component.

■ JClass JarMaster, which makes packaging and managing your classes to ensure fast 
download easy.

■ JClass LiveTable, which is a high quality grid/table JavaBean for data-driven display.

■ JClass PageLayout, which is the ultimate tool for putting your Java application data 
on paper or on-screen.

Using this Installation Guide
The JClass DesktopViews Installation Guide is broken up into the following sections, 
each geared to further integrate JClass DesktopViews into your environment. 

■ Before installing JClass DesktopViews, we suggest that you first verify that your 
current operating system and IDE are supported and that you are familiar with the 
installation and licensing information in the Installation and Licensing Overview 
chapter before proceeding.

■ Once you are familiar with the information, continue on to either:
❏ Microsoft Windows: Installing and Licensing 
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❏ UNIX: Installing and Licensing

■ Once the product is installed and licensed, the steps required to integrate JClass 
DesktopViews within your development environment are outlined in the 
JClass DesktopViews and your Development Environment chapter.

The Technical Support chapter will provide you with all the information you might need 
to contact Quest’s technical support team if you require assistance in the installation, 
licensing, and integration of JClass DesktopViews.

If you require more information on programming, please refer to the programmer’s 
guides, in the following location following a successful installation:

■ JClass Chart Programmer’s Guide, in JCLASS_HOME/docs/chart 

■ JClass Chart 3D Programmer’s Guide, in JCLASS_HOME/docs/chart3d 

■ JClass DataSource Programmer’s Guide, in JCLASS_HOME/docs/datasource 

■ JClass Elements Programmer’s Guide, in JCLASS_HOME/docs/elements 

■ JClass Field Programmer’s Guide, in JCLASS_HOME/docs/field 

■ JClass HiGrid Programmer’s Guide, in JCLASS_HOME/docs/higrid

■ JClass JarMaster Programmer’s Guide, in JCLASS_HOME/docs/jarmaster (HTML 
only)

■ JClass LiveTable Programmer’s Guide, in JCLASS_HOME/docs/table 

■ JClass PageLayout Programmer’s Guide, in JCLASS_HOME/docs/pagelayout
2 Getting Started with JClass DesktopViews



Supported Platforms
We recommend using the most recent JDK version available for your platform.

JClass 6.3.0 Additional Requirements for 
JClass Chart 3D with Java3D
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MS Windows NT

Sun 1.3.1
Sun 1.4.2

Java3D 1.2.1_04 and higher
2000

XP

Solaris 7

Sun 1.3.1
Sun 1.4.2

Java3D 1.2.1_04 and higher
8

9

Sun 1.4.2 Java3D 1.2.1_04 and higher

HPUX 11

HP 1.3.1
HP 1.4.2

Java3D 1.2.1_04 and higher

IBM AIX 4.3.3

IBM 1.3.1 Java3D as supported by IBM

5.1

IBM 1.3.1
IBM 1.4.1

5.2

RedHat Linux AS 2.1

Sun 1.4.2 Java3D 1.2.1_04 and higher

Mac OS X 10.2

Apple 1.4.1
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Netscape 7.0 or 7.0 or later

with Java Plug-in

MS Internet 
Explorer 

5.0, 5.5, or 6.0

with Java Plug-in

Supported IDEs
IDE Capability

Compiling and 
Javadoc Using JavaBeans

Borland JBuilder 7

8

9

IBM WebSphere Studio 
Application Developer

5.0

5.1

Eclipse 2.1

NetBeans 3.5

Sun Java Studio 5, Standard 
Edition

IntelliJ IDEA 3.x

JClass 6.3.0 Additional Requirements for 
JClass Chart 3D with Java3D
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Installation and Licensing Overview
JClass DesktopViews Installation Files

Installed Directories ■ Licensing Overview ■ Upgrading a JClass DesktopViews Installation

The JClass DesktopViews installation is comprised of two parts: 

■ extracting and installing the product 

■ installing the license file

The JClass License Wizard contains online Help to assist you through this installation 
process.

JClass DesktopViews Installation Files
If you purchased a physical kit, your JClass installation CD contains JClass Chart, 
JClass Chart 3D, JClass DataSource, JClass Elements, JClass Field, JClass HiGrid, 
JClass JarMaster, JClass LiveTable, and JClass PageLayout packaged for installation on 
Microsoft Windows, UNIX, and other development platforms; if you purchased the 
product online, download the appropriate development platform(s) installer(s) for your 
environment. 

Target Platform JClass DesktopViews

Windows NT jcdesktopviews630.exe

2000

XP

AIX 4.33 jcdesktopviews630-aix.bin

5.1

5.2

Solaris 7 jcdesktopviews630-sol.bin

8

9

HPUX 11 jcdesktopviews630-hp.bin
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To continue with the installation, ensure that you have a valid license file. 

Installed Directories
The following directory structure is created on your system when you install 
JClass DesktopViews. 

Please note that throughout this document we use the environment variable 
JCLASS_HOME to represent the directory on your system where you have installed 
JClass DesktopViews.

RedHat 
Linux

AS 2.1 jcdesktopviews630-lnx.bin

Mac OS X v10.2 jcdesktopviews630-mac.bin

Target Platform JClass DesktopViews
6 Getting Started with JClass DesktopViews



Licensing Overview
In order to use the production version JClass DesktopViews, you need a valid license file. 
To install and use an evaluation version of JClass DesktopViews, no license is required. 

Please note that an evaluation installation only allows you to test the different 
JClass DesktopViews functionality for a limited period of time. You have access to demos 
and examples and you can begin prototype level development of your code, but you can 
not use it in a production environment and there may be an “evaluation” watermark in 
the generated output.

Licenses are transferable; please email support@quest.com, or telephone 1-800-663-4723. 
To purchase any JClass product, please contact Quest Software at 
https://apps2.quest.com/queststore/ or telephone 1-949-754-8000.

Production
A Production license allows you full access to the JClass DesktopViews products for 
development and production, eliminating the watermark. 

You can purchase the JClass source code as well.

The License Repository

A license file (typically named jclass-desktopviews.license) is emailed to you from Quest 
Software. Once you receive this file, you will be able to install JClass DesktopViews on 
the licensed host. The license repository will be created during installation and then will 
be found in the JCLASS_HOME/licenses/ directory.

Using JClass DesktopViews and JClass ServerViews

JClass ServerViews are pure J2EE components for generating interactive charts and PDF 
documents on the fly, bringing live professional data visualization to Web browsers.

To use both JClass ServerViews and JClass DesktopViews on the same machine, a 
separate classpath setting must exist for each product. Since both products have 
components in common, which have been optimized for each product, placing them on 
the same classpath will result in the virtual machine and/or compiler automatically 
choosing the first class that matches. This may be from the wrong product, and may result 
in the desired product not working correctly. 
Installation and Licensing Overview 7
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Upgrading a JClass DesktopViews Installation
You can run different versions of JClass DesktopViews on the same machine. To do so, 
simply run the installer and, when it asks you where you would like to install the product, 
select a different folder than the one where the current JClass installation resides. 

For example, if you already have JClass DesktopViews version 6.0 installed on your 
system, and you accepted the default installation, it will be installed in a JClass 
DesktopViews 6.0 folder. When installing the latest version, use a different folder name, 
such as JClass DesktopViews 6.3.

If you would like to install the latest version of JClass DesktopViews without keeping any 
past versions, you must first run the uninstaller to remove JClass from your system. 
Proceed with installing JClass, as outlined in Installing and Licensing JClass 
DesktopViews in Microsoft Windows or Installing and Licensing JClass DesktopViews on 
UNIX.

Note: When installing a newer version of JClass, it is essential that the new and old JAR 
files do not mix. For that reason, do not install a new version over top of an old version; 
either uninstall the older version first, or install the new version in a different folder.

Changing your license
To update your license, launch the license wizard, delete the old license and add the new 
one.

Once you have updated your license in the license wizard, it is important to verify that 
the JAR files you intend to use are correctly referenced. You should check your classpath 
and IDE preferences to ensure that you are not referencing old product versions.
8 Getting Started with JClass DesktopViews



Microsoft Windows:
Installing and Licensing

Installing and Licensing JClass DesktopViews in Microsoft Windows

Installing and Licensing JClass DesktopViews in 
Microsoft Windows
1. Insert the JClass CD or download the installation executable.

To run the executable file, jcdesktopviews630.exe, double-click it. Once running, follow 
the instructions given by the installation program.

2. Install the product files.

Follow the instructions given by the installation program.

3. Ensure that JCLASS_HOME is set correctly.

While setting the JCLASS_HOME is optional, it is highly recommended as it adds a 
valuable level of platform and file system independence.

JCLASS_HOME should be set correctly by the installation program. If not, you can 
set it manually at a command prompt. Example of manual installation:

    set JCLASS_HOME=C:\JClassDesktopViews_630

where C:\JClassDesktopViews_630 is the JClass installation directory.

Note: Though we suggest that you set your JCLASS_HOME environment variable, 
this is not required for JClass DesktopViews to function properly.

4. Run the License Wizard to install the JClass DesktopViews license.

The License Wizard automatically launches while you are running the installer. 

Adding a License File to JClass JARs
Using the JClass License Wizard, you may also install your license file into 
JClass DesktopViews JAR files. 

Once you have selected the product(s) you want to install, the License Wizard allows you 
to choose whether you want to add your license file to JClass DesktopViews JARs.
9



If you choose not to add your license file to JClass DesktopViews JARs with the License 
Wizard during the installation and later decide to add them, simply run the License 
Wizard again and add them.
10 Getting Started with JClass DesktopViews



UNIX:
Installing and Licensing

Installing and Licensing JClass DesktopViews on UNIX

Installing and Licensing JClass DesktopViews on 
UNIX
1. Insert the JClass CD or download the installation executable.

2. Install the product files.

To determine the appropriate installation file for your UNIX environment, please 
refer to JClass DesktopViews Installation Files in the first chapter of this document.

You can launch the JClass DesktopViews installer from a GUI or from the command 
line. In both cases, the installer will be the same.

■ GUI: Right click the appropriate installation file and select the option to view its 
properties or change its permissions (the name of this option will vary 
depending on your platform). Enable the Execute permission for at least the 
file’s owner, and save your changes. Double-click the file in the file manager to 
start the installation.

■ Command-line: Execute the installer by typing:
sh jcdesktopviews630-*.bin

where * indicates the proper platform. 

Follow the instructions given by the installation program.

3. Ensure that JCLASS_HOME is set correctly.

While setting the JCLASS_HOME is optional, it is highly recommended as it adds a 
valuable level of platform and file system independence.

JCLASS_HOME should be set correctly by the installation program. If not, you can 
set it manually at a command prompt. Example of manual installation:

 setenv JCLASS_HOME /opt/JClassDesktopViews_630

where /opt/JClassDesktopViews_630 is where you installed the 
JClass DesktopViews product(s).

Note: Though we suggest that you set your JCLASS_HOME environment variable, 
this is not required for JClass DesktopViews to function properly.
11



4. Run the License Wizard to install the JClass DesktopViews license.

The License Wizard automatically launches while you are running the installer. 

To run the license again, go to the JCLASS_HOME/bin directory and double click 
license.exe. Follow the instructions to install the license.

Adding a License File to JClass JARs
Using the JClass License Wizard, you may also install your license file into 
JClass DesktopViews JAR files. 

Once you have selected the product(s) you want to install, the License Wizard allows you 
to choose whether you want to add your license file to JClass DesktopViews JARs.

If you choose not to add your license file to JClass DesktopViews JARs with the License 
Wizard during the installation and later decide to add them, simply run the License 
Wizard again and add them.
12 Getting Started with JClass DesktopViews



JClass DesktopViews and your
Development Environment

JClass DesktopViews JAR Files ■ JClass DesktopViews and your CLASSPATH

Integrating JClass DesktopViews into your Ant Build Scripts ■ Demos and Examples

JClass DesktopViews JAR Files
The JClass JAR files are located in the lib subdirectory of your JClass DesktopViews 
installation. Several JClass products have versions that are optimized for databinding with 
an IDE or with JClass DataSource. The following table helps determine the JClass 
product JAR file to install for use with your application.

Other JAR Files

Along with the standard JClass DesktopViews JARs, your installation will include three 
other JARs files:

Platform Standard Databinding with 
Borland JBuilder 6

Databinding with 
JClass DataSource

Java 2
( JDK 1.3.1+)

jcchart.jar
jcchart3dj2d.jar
jcchart3dj3d.jar
jcdatasource.jar
jcelements.jar
jcfield.jar
jchigrid.jar
jcpagelayout.jar
jctable.jar
jcjarmaster.jar

jcchartjb.jar
jcfieldjb.jar
jctablejb.jar

jcchartds.jar
jcfieldds.jar
jctableds.jar

JAR Usage

crimson The crimson JAR is a SAX XML parser.

JAXP The java standard XML parser interface ( Java API for XML 
Parser).

vecmath The vecmath JAR is required by JClass Chart 3D; it contains 
utility classes that facilitate some of the matrix calculations 
that must be performed by JClass Chart 3D.
13



JClass DesktopViews and your CLASSPATH
The Java Virtual Machine ( JVM) and other applications use the CLASSPATH 
environment variable to locate user-defined classes. You should ensure that the 
CLASSPATH points to the location of the JClass DesktopViews JAR files (and any other 
classes you develop). The Windows installation program does this automatically. UNIX 
users must manually configure their CLASSPATH. 

Two entries should be part of the CLASSPATH:

■ one specifying the JClass product classes (a JAR file located in the product’s \lib\ 
directory)

■ one specifying the installation directory (necessary to run JClass example and demo 
programs). You should not need to extract the JAR archive to develop with 
JClass DesktopViews products

Setting the CLASSPATH in Windows 2000 and Windows XP
Open the Control Panel and select System. Locate the environment variables on the 
Environment tab (NT) or Advanced tab (Windows 2000 and Windows XP). 

Look for a CLASSPATH environment variable (if it doesn’t exist, create it), and make 
sure that the JClass JAR location and home location are in the variable. For example, to 
include JClass Chart in the CLASSPATH, add the following value to the variable:

[existing-classes];C:\JCLASS_HOME\lib\jcchart.jar;C:\JCLASS_HOME;
14 Getting Started with JClass DesktopViews



The following illustrates a CLASSPATH setting on Windows NT; your actual setting may 
vary or have additional directories/JAR files.

Setting the CLASSPATH in UNIX

In UNIX, you must manually configure the CLASSPATH environment variable before 
you can start using any JClass DesktopViews product. The CLASSPATH must point to 
the location of the classes and installation directory.

For example, to set the CLASSPATH for JClass Chart, add a setenv command to your 
startup file (such as .cshrc) to set CLASSPATH to point to the classes, for example:

    setenv CLASSPATH $CLASSPATH
${JCLASS_HOME}/lib/jcchart.jar:
${JCLASS_HOME}

If you are using the Bourne Shell, the commands are:

    CLASSPATH=$CLASSPATH:/${JCLASS_HOME}/lib/jcchart.jar:
${JCLASS_HOME}

    export CLASSPATH
JClass DesktopViews and your Development Environment 15



Integrating JClass DesktopViews into your Ant Build 
Scripts
In order to compile your JClass application using the popular Ant build tool, you must 
ensure that the JClass JAR files you are using are specified in the CLASSPATH of the 
<javac> task that performs the compilation. If your environment's CLASSPATH setting 
includes the JClass JARs, then they will automatically be available for any <javac> task 
you use. However, we recommend that you specify explicitly the JClass JAR files to be 
used via a nested <fileset>. For example:

<project name="JClassApp">
<!-- Enable the prefix env for accessing environment variables -->
<property environment="env" />

    <!-- Set a property, jcse_home, to be used throughout the build file when
referring to your JClass installation -->       

    <property name="jcse_home" value="env.JCLASS_HOME" />

    <!-- Set some properties specific to our application -->
    <property name="srcdir" value="src" />
    <property name="builddir" value="build" />

    <!-- Create a path containing the required JClass JAR files -->
    <path id="jclass_jars">
        <fileset dir="${jcse_home}/lib">
            <include name="*.jar" />
        </fileset>
    </path>

    <target name="compile" description="Compiles all .java files in our 
JClass application src directory">

        <javac srcdir="${srcdir}"
               sourcepath=""
               includeAntRuntime="no"
               includeJavaRuntime="no"
               fork="yes">  

<!-- Make sure to fork a new process to ensure your
explicit settings are used -->

            <classpath refid="jclass_jars" />  
<!-- Specify the JClass jars on the 'CLASSPATH' -->

            <patternset refid="**/*.java" /> 
        </javac>
    </target>    

</project> 

Your JClass installation includes an Ant script that demonstrates various ways of 
integrating JClass with your Ant environment, using the demos and examples as a sample 
"application". Located in the bin directory, execute ant -f demobuilder.xml for 
instructions on how to use the various tasks it contains.
16 Getting Started with JClass DesktopViews



Demos and Examples
JClass products include an Example & Demo Gallery. Demos are meant to show real-
world uses of the product, while examples provide short, simple code examples for 
particular components. When you install a JClass product, the demos and examples of 
that product will automatically be installed.

Your CLASSPATH and JCLASS_HOME environment variables must be set correctly in 
order to run the demos and examples.

Note: UNIX (as well as Windows) users can run the Example & Demo Gallery via an 
executable. You can run the launchers by entering the following at a command prompt:

    cd JCLASS_HOME/bin
    jcexamples
JClass DesktopViews and your Development Environment 17
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Integrating JClass DesktopViews
within your IDE

Borland JBuilder 7 or higher

IBM WebSphere Studio Application Developer 5.0, 5.1, and Eclipse 2.1

Sun Java Studio 5, Standard Edition, and NetBeans 3.5

This chapter outlines how JClass DesktopViews can be integrated within several popular 
IDEs. Please note that only IBM WebSphere Studio Application Developer is supported 
on both Window and UNIX platforms.

Borland JBuilder 7 or higher
For full details on using JavaBeans with Borland JBuilder, please refer to the 
documentation that came with JBuilder. We provide an overview here. 

Note: Only the 2D version of the JClass Chart 3D JavaBean works in JBuilder, and you 
will need to add vecmath.jar to your project.

1. Make a library available to JBuilder by clicking Configure Libraries in the Tools 
menu and navigating to the library you want to add. Alternatively, add the required 
libraries in the Project Wizard.

2. Click the New button and fill in the Name and the Location for your new library. 
When completed, select the required JAR files and click OK. 

3. From JBuilder’s Tools menu, choose Configure Palette... (or right-click the 
component palette and choose Properties...).
19



4. From the Pages tab of the Palette Properties dialog, click Add... to create a new 
page. Label this page, for example, Quest (alternatively, create a new page for each 
JClass product that you install).

5. Click on this new page name and select the Add Components tab of the Palette 
Properties dialog.

6. Click Select Library and browse to where you installed your JClass library, then 
click OK. 

7. In the Palette page to receive components box, select the page where you want 
this component to be stored (for example, Quest).

8. Select the component(s) that you wish to install.

9. Click Add from Selected Library... to view Results window, which contains the list 
of Beans in your selected library. Click OK. This will return you to the Palette 
Properties window.

10. When you return to the Palette Properties window, click OK.

For more information, see the JBuilder help.

You should now see your page name in the component palette. When you click on it, 
icons for the Beans you added will appear. When you are in JBuilder’s Design mode you 
will be able to drop the components into the frame.

■ Please note that limited versions of JClass products come with JBuilder. If you add the 
full or evaluation version of JClass Chart and JClass LiveTable to JBuilder, the limited 
versions will remain as separate tabs on the palette. If you would like to remove the 
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limited versions, simply right-click the component palette and choose Properties...; 
highlight the components that you want to delete and click Remove, then OK. Also, 
remove the Quest libraries.

Removing a JClass Product from Borland JBuilder
Using the Add/Remove Programs dialog in the Control Panel does not remove a 
JClass product from JBuilder. You must manually configure JBuilder to remove all 
references to the JClass product:

■ Remove the JClass product from the default Java libraries list using the Default 
Project Properties dialog (Project | Default Properties...).

■ To remove the JClass product tab from the Palette, right-click the palette, select 
Properties... then click the Remove button and press OK.
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IBM WebSphere Studio Application Developer 5.0, 
5.1, and Eclipse 2.1

Using JClass JavaBeans in IBM WebSphere Studio Application Developer 5.0 and 5.1

1. From the File menu, select New then Visual Class.

2. In the Create New Java Class using Visual Editor window, define the Source Folder (either 
by entering the name in the field, or by clicking the Browse... button and navigating 
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to an existing folder), and enter a name for the Java class in the Name field. For 
example, MyClass.

3. Continue adding information about your new Java class until you are satisfied, then 
click the Finish button. The visual editor’s workbench will appear.

4. Right click the name of the Java project in the Packages window, and select 
Properties.
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5. Select Java Build Path in the list, and click the Libraries tab.

6. Click the Add External JARs... button. In the JAR Selection window, navigate to the 
JCLASS_HOME/lib directory. Select the appropriate JARs from the list, and click the 
Open button. 

7. Click the OK button on the Properties window to return to the visual editor.
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Using the JClass JavaBeans

1. To use the JavaBeans, click the  (Choose Bean) button. In the Choose Bean 
window, select either the AWT or Swing radio button, and choose a JAR and class 
from the lists. Click the OK button.

Note: If you already know the path for the class, you can type it into the File Selection 
text box instead of selecting it from the list. (For example, type 
com.klgjclass.chart.JCChart.)
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2. Click and drag on the visual editor to place the component in the file.

Removing JClass JavaBeans from a WebSphere Studio Application Developer 5.0 Java Class

1. To remove JavaBeans from WebSphere Studio Application Developer, right click the 
name of the Java class from which you would like to remove the Beans, and select 
Properties.

2. From the Properties window, go to the Libraries tab and select the JavaBeans from the 
list that you would like to eliminate. Click the Remove button.

Sun Java Studio 5, Standard Edition, and NetBeans 
3.5
For full details on using JavaBeans with Sun ONE Studio, please refer to the 
documentation provided with Sun ONE Studio. We provide an overview here.
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1. From the Tools menu, select Options. From the resulting Options window, select IDE 
Config/Look and Feel.

2. Right click Component Palette and, from the drop-down list, select Add Palette 
Category.

3. In the New Palette Category window, enter a name for the new palette (for example, 
Quest) and click the OK button. Close the Options window.
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4. To add Beans to the palette, go to Tools/Install New Java Bean. In the Install 
JavaBean window, navigate to the location of your JClass JARs, select the appropriate 
JAR, and click OK. 

5. From the resulting Select JavaBean window, select the JavaBeans from the JAR that 
you would like to install and click OK.
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6. From the Palette Category window, select the palette where you would like the 
JavaBeans to appear (for example, Quest) and click OK.

7. Your Beans will be located at the top of any open form editor.

Removing JClass JavaBeans from Sun ONE Studio 4 Community Edition

1. To remove JClass Beans, go to the Tools menu and select Global Options. 

2. In the Global Options (or Options) window, view the Component Palette and open 
the palette category where your Bean is located.
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3. Right click on the Bean you would like to remove and select Delete from the drop-
down menu. (You can also select the Bean and hit the Delete key.)

4. When the Confirm Object Deletion window appears, click Yes.

5. Next, you must remove the JClass JAR from the filesystem. To do so, right click on 
the filesystem you want to remove (the JClass filesystem) in Forte’s Explorer window 
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and select Unmount Filesystem from the menu. (You can also unmount the 
filesystem by going to the File menu and selecting Unmount Filesystem.)
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Technical Support
About Quest ■ Contacting Quest Software ■ Customer Support

Product Feedback and Announcements

About Quest
Quest Software, Inc. (NASDAQ: QSFT) is a leading provider of application management 
solutions. Quest provides customers with Application Confidencesm by delivering 
reliable software products to develop, deploy, manage and maintain enterprise 
applications without expensive downtime or business interruption. Targeting high 
availability, monitoring, database management and Microsoft infrastructure 
management, Quest products increase the performance and uptime of business-critical 
applications and enable IT professionals to achieve more with fewer resources. 
Headquartered in Irvine, Calif., Quest Software has offices around the globe and more 
than 18,000 global customers, including 75% of the Fortune 500. For more information on 
Quest Software, visit www.quest.com.

Contacting Quest Software

Please refer to our Web site for regional and international office information.

E-mail sales@quest.com

Address

Quest Software, Inc.
World Headquarters
8001 Irvine Center Drive
Irvine, CA 92618
USA

Web site www.quest.com

Phone 949.754.8000 (United States and Canada)
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Customer Support
Quest Software’s world-class support team is dedicated to ensuring successful product 
installation and use for all Quest Software solutions.

You can use SupportLink to do the following:

■ Create, update, or view support requests

■ Search the knowledge base, a searchable collection of information including program 
samples and problem/resolution documents

■ Access FAQs

■ Download patches

■ Acquire product documentation, API reference, and demos and examples

Please note that many of the initial questions you may have will concern basic installation 
or configuration issues. Consult this product’s readme file and the Getting Started Guide 
(available in HTML and PDF formats) for help with these types of problems.

To Contact JClass Support
Any request for support must include your JClass product serial number. Supplying the 
following information will help us serve you better:

■ Your name, email address, telephone number, company name, and country

■ The product name, version and serial number

■ The JDK (and IDE, if applicable) that you are using

■ The type and version of the operating system you are using

■ Your development environment and its version

■ A full description of the problem, including any error messages and the steps required 
to duplicate it

SupportLink www.quest.com/support

E-mail support@quest.com

JClass Direct Technical Support 

JClass Support Email support@quest.com

Telephone 949-754-8000

Fax 949-754-8999

European Customers
Contact Information

Telephone: +31 (0)20 510-6700
Fax: +31 (0)20 470-0326
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Product Feedback and Announcements
We are interested in hearing about how you use JClass DesktopViews, any problems you 
encounter, or any additional features you would find helpful. The majority of 
enhancements to JClass products are the result of customer requests.

Please send your comments to: 
Quest Software
8001 Irvine Center Drive
Irvine, CA 92618

Telephone: 949-754-8000
Fax: 949-754-8999
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